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The NFL Amateur Radio Club 

Meets the second Saturday of each month at 12:00 noon lunch 
and 1:00 PM Meeting at the NFLARC clubhouse, near Dobins 
Rd & CR1020 Corsicana 
�
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The Linked Repeaters at 
·  Corsicana - 2M (145.290 + with a tone of 146.2) 
·  Corsicana – DMR 440 (442.925) 

·  Buffalo - 2M (147.280 + with a tone of 146.2) 
·  Franklin - 2M (146.960 - with a tone of 146.2) 
·  Hillsboro - 2M (146.780 - with a tone of 123.0) 
·  �������� �!��"�#�$%�����!�&�'(���')*��)���$	��+�
·  ��* ����!��"�#�$%�	���,�-.��/�&�'(���')*��)��

�$	��+�
·  "�/���!��"�#�$%�01���&�'(���')*��)���$	��+�
·  
2()��*3�!�45%�6"���
·  ���2�*�7��")*�')�� �8���

o (''.9::*����2�)��:�� �)�('-��
o (''.9::&&&��� �)������*2��2)-�

�  �))3��)��
�  ��8���);�����,')*�;���-�,')*��
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·  Corsicana – DMR 440 (442.925+ cc9) 
9 Local (PTT activated with 10 min inactivity timeout) 

2 Dallas Metro  (Primary) 

3148 TX Statewide (Primary) 

3175 TX-OK Statewide (PTT activated with 10 min inactivity timeout) 

9000 TX Statewide Brandmesiter (PTT activated with 10 min inactivity 
timeout) 

3 North America (PTT activated with 10 min inactivity timeout)  

1 Worldwide All Languages (PTT activated with 10 min inactivity 
timeout)  

3100 Bridge (PTT activated with 10 min inactivity timeout)  

310 Tac 310 (PTT activated with 10 min inactivity timeout)  

3777215 Comm 1 (PTT activated with 10 min inactivity timeout) 

 
 
 

License Training Class / Testing�

Test session 7-1-2016 12:00 noon Corsicana Library 
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Local News & Events�
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DMR # Call - Name 
3148591 K5RCM - Rebekah 
3140265 KA5LSU - William 
3148585 KD5JUM - Edward 
3148505 KD5OXM - James 
3148434 KE5CDK - Doug 
3148590 KE5CDK - Doug 
3148474 KE5FGU - Mary 
3148517 KE5YPH - Joe 
3148589 KW5MOS - Kevin 
3140264 WA5LSH - Tracie 
3148586 WB5YFX - Wil 

�
�
�

NFLARC Weather Nets 

�
�
NFLARC Weather Net Frequencies: 
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·  Corsicana - 2M (145.290 + with a tone of 146.2) 
·  Corsicana - 440 (442.925 DMR CC9 TG-Local) 
·  Buffalo - 2M (147.280 + with a tone of 146.2) 
·  Franklin - 2M (146.960 - with a tone of 146.2) 
·  Hillsboro - 2M (146.780 - with a tone of 123.0) 
·  Fairfield - 2M (145.110 * with a tone of 146.2) 
·  Lindale - 2M (145.600 simplex with a tone of 146.2) 
·  Mexia - 2M (145.39 - with a tone of 146.2) 
·  Simplex Frequency - 146.500 MHz 
·  Echolink - KD5OXM-L�

 
 
 

ARES Net�
�

�
�
Limestone ARES Group 
ARES group for Limestone Co. 
List their Coms plan as follows: 

·   Repeaters 
o Mexia Repeater 145.39 – Primary 
o Corsicana Repeater 145.29 – Secondary 
o Simplex 
o 146.500 FM Primary 
o 146.550 FM Secondary 
o 147.550 FM Texas State Guard Freq 

�
They will have a weekly net on Tuesday Nights 8PM on "�/���
��.��'����$%�01  
�

World News & Event�
 
 
Membership in ARRL now cost $49.00 a year. 
 
------------------------------------------------------------------------ 
 
IARU - Custodian of Operating Standards 
 
Over the last eight years, the booklet 'Ethics and Operating 
Procedures for the Radio Amateur' has become a respected work 
describing the best standards of operating on the amateur bands  
Translated into most major languages, the booklet by John 
Devoldere, ON4UN and Mark Demeuleneere, ON4WW, is a 
valuable reference work for all radio amateurs. 

Mark and John recently contacted IARU, explaining that they 
felt it appropriate for IARU to become the custodian of the 
booklet into the future, with the scope to adapt and update it to 
ensure it remains relevant and current.  
The IARU Administrative Council accepted this offer with 
gratitude to John and Mark for the work they have put into the 
document.  
IARU will now carry forward the work in future years to ensure 
its continuing relevance and currency. 
Booklet - http://www.hamradio-operating-ethics.org/ 
 
IARU http://iaru.org/ 
 
-------------------------------------------------------------------------- 
 
Radio Hams Prepare Florida Hurricane Season 
 
Hurricane season is approaching in Florida, and Amateur / Ham 
Radio Operators are getting ready to support. 
Operators are emphasising the importance of the tests, noting 
that when the power and internet go out, ham radios are a 
dependable source of communication. 
 
“It’s basically resource allocation. Let’s say there are 5,000 
people at the shelter in Palm Beach, and we need to get them 
food, we need to get them water, the roads are out on I-95, 
people can’t travel the roads.”  
— Barry Porter KB1PA  
 
These type of tests take place three to four times a year.     
Porter says his ham radios are extremely useful during powerful 
hurricanes where some areas lose power for days. 
 
News Report -  
http://www.wptv.com/news/state/statewide-tests-underway-for-
ham-radios-as-hurricane-season-nears 
 
--------------------------------------------------------------------------- 
 
Using Amateur Radio to Enhance Engineering Education 
 
Amateur Radio hobby was recently discussed at upcoming IEEE 
MTT International Microwave Symposium (IMS). 
IMS is the premier annual international meeting for professional 
technologists involved in all aspects of microwave theory and 
practice. 
On Tuesday, May 24 professors from universities in the United 
States and elsewhere will discuss the specific ways amateur 
radio is being integrated into their engineering education. The 
professors discussed how electronics/engineering education 
using amateur radio is effective, and the impact amateur radio-
based instruction has had on their curricular and success of their 
graduates.  
Panel Organizers and Moderators 

·  Suresh Ojha W6KTM, National Instruments, Santa 
Clara, CA 
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·  David Witkowski W6DTW, Joint Venture Silicon 
Valley, San Jose, CA 

·  Beric Dunn K6BEZ, Tarana Wireless, Santa Clara, CA 
Panelists 

·  Dennis Derickson AC0P, California Polytechnic 
University 

·  Bob Iannucci W6EI, Carnegie Mellon University 
·  Xiaoguang Liu AI6DW, University of California, 

Davis  
·  Sanjeeb Panday 9N1SP, Tribhuvan University 

 
IEEE MTT International Microwave Symposium - 
http://www.ims2016.org/ 
 
------------------------------------------------------------------------ 
 
Ham Radio at Scout 'Camporee' 
 
Members of the Central New Hampshire Amateur Radio Club 
helped local scouts make contact with their fellow scouts in 
Georgia  
Vice president of Central New Hampshire Amateur Radio Club 
 (CNHAR) Glen Aldrich KC1AAI attended a Boy Scout 
"Camporee" held in May 2016 at Camp Bell, part of the 
Griswold Scout Reservation, just off 159 Manning Lake Road in 
a secluded part of Gilmanton Iron Works. 
The two day camp event was attended by 80 scouts with all of 
them involved in two amateur radio competitions. 
One competition had scouts getting on the air and making radio 
contact with others at specific spots in the vicinity of the camp. 
 The other competition featured radio contact in a simulated 
search and rescue aid exercise.  The Meredith troop won both 
segments of the competition. 
The scouts also succeeded in long distance communication, 
using an Icom 706 to make contact with a Boy Scout troop in 
Columbus, Georgia.  The youngsters operated an assortment of 
other equipment during the Camporee including computer 
digital, voice, and CW Morse code.  Power was supplied through 
a unit called a "go kit." 
 
Full Story - http://www.citizen.com/news/2016-05-14/Local/ 
Central_New_Hampshire_Amateur_Radio_Club_helps_Boy.ht
ml 
 
Central New Hampshire Amateur Radio Club - 
http://www.cnharc.org/ 
 
---------------------------------------------------------------------- 
 
UK Schools Mass launch of 434 MHz Balloons 
 
UK Schools have successfully launched 25 balloons transmitting 
on 443 MHz. 

The launch took place at RAF Cosford, with each attached 
payload containing a Raspberry Pi and tracker telemetry 
transmitting on a frequency range of 434.010 to 434.790 MHz. 
TV Presenter Jason Bradbury, 2E0JAB took part in the launch, 
his balloon reached 33km before bursting. Bradbury’s balloon 
was found stuck in a tall tree! 
 
Pi In The Sky telemetry board - http://pi-in-the-sky.com/ 
 
Sent into Space - http://sentintospace.com/ 
 
---------------------------------------------------------------------------- 
 
 

Funnies 
 

 
 
 

History  
 
The Transistor: a 1953 documentary, anticipating its coming 
impact on technology  
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Made between the 1947 invention of the transistor at Bell Labs 
and the 1956 awarding of the Nobel Prize for Physics to its 
creators, this documentary is less about the discovery itself than 
its anticipated impact on technology and society. The intent of 
the film was clearly to give the public of that era their first 
understanding of what a transistor was and why it mattered so 
much. 
 
Made for a general audience, the film provides a clear and 
concise presentation on technological developments that began 
with the vacuum tube, showing different types of transistors and 
explaining the significance in their ultimate replacement of 
tubes. 
 
Included are visions of “things to come,” concepts and creations 
of how the small transistor might free up an encumbered world: 
the wrist radio, similar to Dick Tracy’s, but with a cool lapel 
sound speaker worn like a boutonniere; a portable TV set, which 
must have seemed astonishing at the time given the huge, heavy 
cabinetry required to accommodate the plethora of tubes inside 
1950s TVs; and the “calculating machine,” or computer, whose 
size, we’re told, will one day be so reduced because of 
transistors that it will only require “a good-sized room” rather 
than a space the size of the Empire State Building. The concept 
of how small computers could be still remained decades away. 
 
While The Transistor’s vision of the future seems somewhat 
quaint in retrospect, it captures a moment in time before the 
transistor became ubiquitous; a time when Bell Labs wanted the 
world to know that something important had occurred, 
something that was about to bring tremendous change to 
everyone’s daily lives. 
 
 
https://www.youtube.com/watch?v=V9xUQWo4vN0 
 
------------------------------------------------------------------------- 
 
AM, The Original Speech Transmission Mode 
 

 
 
Here’s a question: when did you last listen to an AM radio 
station?  
If your answer is “recently”, chances are you are in the minority. 
 

You might ask: why should you listen to AM? And you’d have a 
point, after all FM, digital, online, and satellite stations offer 
much higher quality audio, stereo, and meta information, and 
can now be received almost anywhere. Even digital receivers are 
pretty cheap now, and it’s by no means uncommon for them to 
not even feature the AM broadcast band at all. Certainly this has 
driven an exodus of listeners to the extent that AM radio has 
been in slow decline for decades, indeed it’s disappearing 
completely in some European countries. 
 
Amplitude Modulation 
On your radio receiver “AM” will probably refer to the 
broadcast band between about 550KHz and 1600kHz depending 
on where you are in the world, also known as “Medium Wave”. 
But AM itself is not related to a particular frequency, instead it 
refers to “Amplitude Modulation”, and was the original 
modulation mode for conveying speech and music. You’ll also 
find it on the shortwave (HF) broadcast bands and in CB radio. 
With a modified sideband structure it provided the modulation 
scheme for analogue television. 
 
The simplest form of AM transmitter takes the output of an 
audio power amplifier and mixes it with that of an RF power 
amplifier. This is normally done by applying the audio to the 
power supply of the RF amplifier and is referred to as series 
modulation. The textbooks describe the effect of AM modulation 
in the time domain with the supposition of a pair of 
waveforms to form a modulation envelope, but the story is better 
told in the frequency domain. There an AM signal has a central 
constant carrier wave with symmetric sidebands containing the 
audio information. The overall bandwidth of the transmission is 
thus twice the bandwidth of the audio. 
 

 
Amplitude modulation in the time domain. Ivan Akira [CC BY-
SA 3.0], via Wikimedia Commons. 
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Amplitude modulation in the frequency domain. Heron2 [CC 
BY-SA 3.0], via Wikimedia Commons. 
 
Looking at the two graphs depicting the AM signal, we can start 
to appreciate some of the system’s flaws. 
 
In the time domain, the varying amplitude of the signal means 
that it is vulnerable to interference from  any other RF sources 
within its bandwidth whose amplitude also varies. Lightning 
strikes, switching transients, noise from faulty switch-mode 
power supplies and more can all be heard when they occur in the 
background of an AM transmission. It’s not all bad, if you live 
on a farm you might have found it useful to always know when 
your electric fence is working from the tick… tick… tick… on 
your radio. 
Meanwhile, in the frequency domain, the width of those 
sidebands is proportional to the bandwidth of the audio being 
modulated. For a higher quality audio source with a 15kHz 
bandwidth for example, the total AM bandwidth would be 
30kHz. The demands of the spectrum regulators to fit as many 
broadcast stations as possible into the available bandwidth mean 
that depending where in the world you live each channel will be 
allocated only 9 or 10 kHz, so the practical audio bandwidth is 
reduced to around 5kHz. Thus as well as being vulnerable to 
interference, the AM broadcast also sounds poor, especially for 
music, compared to its FM competitor. 
 
Cheap Plastic 
The final nail in the coffin for the quality of AM broadcasts 
comes from the typical modern AM receiver. In AM 
broadcasting’s early years, a radio receiver was a premium 
 product, comparable perhaps to a modern 4K TV set. The radio 
manufacturers of the 1920s and 1930s were in fierce competition 
to deliver technical innovations to improve their product’s sound 
quality in all areas, and the best radios had extremely high 
quality amplifiers and speaker cabinets. This was the golden age 
of AM broadcasting, when AM stations had more bandwidth in a 
less crowded band, and were a primary entertainment medium. 

By contrast a typical plastic portable AM radio of today is built 
at as low a cost as possible with very little attention to the 
quality of the sound it delivers. Even with a bandwidth-restricted 
modern broadcast station it is obvious just how poor quality 
its sound can be if you compare a cheap plastic portable with a 
high-end 1930s radio or a modern high-end AM receiver like the 
Tivoli Model One. If most people’s experience with AM is low-
bandwidth audio accompanied by electrical noise and played 
back on poor quality electronics through a cheap speaker, is 
there any wonder it’s taken up by ever fewer people? 
 
Golden-Eared Hams 
When AM is treated with some care and attention in both 
transmitter and receiver though, it is capable of delivering very 
good results. Surprisingly there is a small area where you will 
find AM enthusiasts hard at work refining their art, though you 
won’t find them on your broadcast radio. The golden age of AM 
in amateur radio is long past, but there is a dedicated band of 
AM diehards for whom the quality of the received audio is more 
important than achieving distance at all costs. Some of them 
maintain huge “boat anchor” transmitters from many decades 
ago, while others are at the cutting edge with DSP-based AM 
generation at low-level, or class D modulators driving class E 
RF amplifiers. They do this in spite of considerable institutional 
opposition from their national amateur radio lobby groups, or 
maybe in some cases even because of it. 
Whether or not we still have AM broadcasts in the coming 
decades will depend on whether or not a viable niche can be 
found for them. Sometimes, as in the case of the British long-
wave BBC Radio 4 on 198kHz, it has even attained a cult status, 
sparked public demonstrations when its demise is predicted, and 
become a National Treasure. But that is the exception, the 
overall picture is one of decline, which leaves one wondering 
whether it is not the medium that is at fault but its regulation. 
The AM broadcast bands are still run according to rules and 
expectations with their roots in a different century, when a 
medium-wave frequency was a valuable asset and so-called 
“clear channel” high-powered stations covered entire continents. 
Perhaps if we recognised that those days have passed, allowed a 
slightly higher bandwidth at the expense of a lower channel 
count and created a constellation of low-power local stations 
with better quality sound, it might have a future. Otherwise if its 
current decline continues it can’t be long before we’ll be faced 
with a young relative approaching with a dusty transistor radio 
and asking “What does this do?” And as we start to explain to 
the child it’ll dawn on us that with no broadcasts left to receive 
we’ll no longer be able get them into electronics the way so 
many of us did, with a crystal set. 
 
----------------------------------------------------- 
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June 29 marks 7 years since the first USA DMR 
Conversarion for HAMS  
 
 
The First USA Ham IPSC Connection and Conversation 
 
It was June 29, 2009, on Field Day weekend that 3 Hams got 
together with 3 MotoTRBO XPR-8300 repeaters located in 2 
different states and connected those repeaters together via IPSC.  
 
Repeater Firmware version R01.04.09 had just been released and 
was the first version to support IPSC. All 3 hams were using 
XPR-6500's running version R01.04.01 firmware. The 3 Hams 
were: 
Randy, WB0VHB located in Mt. Pleasant Iowa 
Ray, WA6NVL located in Culver City, California 
Mike, WB6WUI (now NO7RF) located in Costa Mesa 
California 
 
All three repeaters were sitting on the desks or countertops and 
all 3 repeaters were the original R01.xx demo repeaters that had 
been sitting on the dealer shelves for several years. These 
repeaters were part of the original Motorola demonstration 
packages provided to dealers that failed to catch wind. 2 of these 
repeaters were purchased from Sandy's Communications. 
Ray WA6NVL made an acoustically coupled recording of this 
first conversation. It is available here via this MP3 
http://www.trbo.org/audio/HistoryTRBO-6-1st-Ccontact-
090627a.mp3. This was the first Ham IPSC conversation in the 
world as far as well know. 
 
From this conversation, TRBO-6 and later DCI networks were 
formed. The c-Bridge came along 21 months later. That was 
really when HAM DMR really took off in huge numbers. 
 
 

New Gear 
 
Shield Hat: Signal Proof Apparel (stylish tin foil cap) 

 

 
 

 
It has shielding effectiveness 55dB-65dB from 10 MHz to 4 
GHz. Silver is also antibacterial, antimicrobial, antiodor and 
antistatic. 
 
http://shieldheadwear.com/ 
 
 
DIY 
 
DIY Powerpole voltage and current meters  
 

 
 
Powerpole voltage and current monitoring is quite nice to have. 
One can buy commercial meters, but due to the availability of 
nice and cheap modules, it is very easy to make them oneself. 
 
To the right you'll see my combined voltage and current meter as 
well as my volt-meter on top of the power supply. 
 
Both of the modules have been bought on Ebay: 

·  Miniature 0-30 V DC LED 2 wire Digital voltmeter 
(371333527599) where the display is 22 by 10 mm. 
Cost slightly more than $1 

·  0-100 V, 0-10 A Dual Voltmeter Ammeter 
(262455987311) costing less than $3. The module size 
is 48 x 29 x 26 mm and the letters are 7 mm tall just 
like the miniature voltage display. 
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The wires to the voltmeter are connected directly to PowerPole 
connectors as shown in the second figure (upper right). Then the 
voltmeter itself is enclosed in transparent shring-wrap tubing of 
diameter approximately 20 mm like the one you also can buy on 
Ebay (252004328030). 
 
The voltage-current meter is a little more complex to connect. 
First the volt meter has a power lead (4-30 V) and a 
measurement lead (0-100 V) which are connected together as I 
will only be using it for 12 Volts. The current measurement loop 
is between the negative, black, PowerPole connectors. The 
positive, red, PowerPole connectors are wired together. 
 
I hope this can inspire others to make something similar. And if 
you do, then please let me know in the comments field! 
 
The post "DIY Powerpole voltage and current meters" first 
appeared on the LA3ZA Radio & Electronics page. 
 
 

Ham Software�
 

 
 
Hi All, 
 
 
I hope that you had a great Field Day!  After operating Field Day 
from my home on emergency power the last few years, I had the 
pleasure of operating 2A with our club, the Northeast Maryland 
Amateur Radio Contest Society as NE3MD.  We had a blast!  If 
you have any questions on submitting your Field Day entry, 
you'll find all the details here:  
http://www.n3fjp.com/faq.html#q68 
 
Amateur Contact Log 5.6 and new versions of all my contesting 
software are now available!  As always, upgrades are free to 
registered users! 
 
I am particularly excited about this release.  One of the new 

features - the ability to check entity confirmation status in your 
main log while contesting - is something I've dreamt about for a 
long time!  I'm also very excited about the ability to use rig 
interface and send CW from multiple programs simultaneously! 
 
There's a lot of ground to cover, so let's start with a summary 
and follow with all the detail. 
 
New Features Summary 
 
-  Ability to check main log entity confirmation status from 
contest software via API. 
 
-  Implementation of an optional History File in all the 
contesting software. 
 
-  Transfer QSO records easily via API (File > Transfer via API). 
 
-  Rig Interface via API (Settings > Rig Interface > N3FJP API). 
 
-  CW via API (Settings > Transmit > CW). 
 
-  DX Spots Summary Graph (View > DX Spots Summary 
Graph). 
 
-  With option to ID LoTW Users enabled, LoTW users will also 
be identified when tabbing from the Call field (eLogs > LoTW > 
ID LoTW Users) (AC Log only). 
 
-  Type a frequency in the Call field and press enter to change 
frequency (with rig interface enabled). 
 
-  Modified frequency change form behavior so that it will 
optionally close on action. 
 
-  Additional API commands (API version 0.7). 
 
-  Winter Field Day Contest Log 1.6 Now Available (reflects 
latest rule changes). 
 
Check Main Log Entity Confirmation Status While Contesting 
 
I am really excited about this new feature!  Something that I've 
always wondered while working contests is whether the juicy 
DX I am calling is confirmed on that band and mode in my main 
log or not.  In fact, some contests are as much about collecting 
new entities as the event itself.  This entity just might be an All 
Time New One!   
 
When contesting, in the heat of the fray, there's never been a 
quick way to check, until now!  Here's how: 
 
-  From Amateur Contact Log 5.6, click Settings > API and 
check the upper checkbox that says TCP API Enabled (Server).  
Leave the lower Client checkbox unchecked. 
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-  In the contest software, click Settings > API and check the 
lower checkbox to Enable Entity Confirmation Check via API.  
Leave the upper Server check box unchecked. 
 
That's all there is to it.  Just enter a call in the contest software's 
Call field for an unconfirmed entity in AC Log and press the 
space bar to tab.  When you tab from the Call field in the 
contesting program, a status query will go out to AC Log via 
API to check the confirmation status and the result will be 
displayed in the contesting software's dialogue box!   
 
If you are running AC Log 5.5, your only alert will be 
unconfirmed on band and mode.  If you are running AC Log 5.6, 
the alert options that will appear in the contest software include: 
 
Entity is an All Time New One 
Entity isn't confirmed on any band or mode 
Entity is confirmed, but hasn't been worked on current band and 
mode 
Entity is confirmed, but is unconfirmed on current band and 
mode 
 
 
There won't be a message if the entity is confirmed on the 
current band and mode. 
 
History File 
 
First, here's a bit of back story, since I've modified my position 
on this request.  Over the years, many of you have asked me to 
add the ability to use a history file to prefill contest data, gleaned 
from exchanges you've had in previous contests.  Until now I've 
been reluctant to implement that feature, believing that the 
exchange should actually be copied at least once during each 
contest.  The following are the most common alternative 
viewpoints that users have been sending along, that have 
successfully, to a degree, changed my position: 
 
-  Even though the data is prefilled, the operator still has to copy 
the exchange to make sure the data is correct for this contest, 
since this time the station you are working may be in a different 
category, etc.  The only benefit is saving the effort of typing.  
The entire exchange still must be heard and understood, so the 
spirit of the contest is preserved and there is no ethical violation 
in using historical data. 
 
-  ARRL, CQ and other organizations don't explicitly exclude 
using historical data to prefill, so it is permissible under the 
current rule set.  N3FJP isn't the rule governing body and 
therefore it is inappropriate for N3FJP to impose additional 
restrictions that aren't addressed in the rules. 
 
-  Most other contesting programs provide a prefill feature.  
Adding this feature will put me on equal contest footing with 
operators using other software alternatives. 
 

-  I'm looking forward to handing out QSOs in this contest, but I 
am not going to submit my log for a contest score, so any rules 
governing history file usage won't apply to my circumstance. 
 
Though history files have been commonly used in many 
contesting programs for some time, most rule sets are silent on 
the use of history files.  In casual conversations with various 
contest sponsors, some governing bodies encourage their use 
while others lean towards opposition.   
 
Personally, I feel that using DX Spotting provides a much 
greater competitive advantage than using historical data does, 
but that historical data is enough of an advantage that anyone 
using it should be required to submit in the Assisted category 
(whether they use DX Spotting or not), but that's just my 
opinion.  As has been rightly pointed out, since I am not part of a 
rules governing body, that's not my call.  As far as I know, you 
can currently use history files in any category. 
 
Like DX Spotting, which is generic in all my software, but only 
allowable in certain contests and categories, the history file 
feature is disabled by default.  You can choose to use your 
history file as you or the contest rules deem appropriate. 
Implementation 
 
Each time you open an applicable contest program, a shared file 
named ContestHistory.txt is read.  As always, when you tab 
from the Call field, the software will first check to see if you 
have worked the same station on another band during this 
contest and fill the pertinent exchange fields.  If you enabled the 
use of the history file (Settings > History File) and you have not 
worked the station during this contest, the software will check 
the history file and fill any fields for which it finds data. 
 
REMEMBER, HISTORY VALUES MAY REQUIRE 
EDITING!  The operator may be using a different exchange this 
time, so don't log the QSO unless you accurately hear and record 
the entire exchange! 
 
When you close the current contest program, the following 
happens: 
 
-  Fields with current values are updated. 
-  Calls new to the history file are added. 
-  Calls for which there have not been any updates for more than 
5 years are removed. 
-  The file is saved. 
 
This history file is updated automatically when you close the 
software, so you build and maintain your history file simply by 
using each N3FJP Software contest program.  If, for example, a 
state or section is exchanged in one program, it will be available 
in the next, even if you are using the second program with the 
history file feature for the first time.  The file is shared among all 
applicable programs and resides in your N3FJP Shared folder 
(File > Show File Locations). 



��������	�
���
�������������������������������������� ������������������������������������������������������������������������������������������ �

������$�

�

 
Note that some contests, like CQ World Wide for example, don't 
receive any added exchange data benefit from the history file, 
simply because it isn't necessary.  All the exchange data in CQ 
WW is already gleaned from the call sign.  Still, I've added the 
history file feature in all the contesting software for consistency.  
It also provides the opportunity to see the name of the person 
you are working, regardless of contest, if the name is part of 
your history file. 
 
During the beta testing process, some users have asked if I am 
going to maintain a comprehensive history file for users to 
download.  I'm not planning on doing that myself, but folks on 
the N3FJP_Software_Users e-mail group have already created a 
history file and made it available for download on the group!  
Others are welcome to do the same! 
 
Transfer QSO Records via API 
 
Transferring your log file via ADIF isn't hard, but with Amateur 
Contact Log 5.6 and the latest versions of my contest software, 
now it is even easier to transfer your QSOs after each contest.  
With Amateur Contact Log's API Server enabled (Settings > 
Application Program Interface), from the contest program, just 
click File > Transfer via API! 
 
Rig Interface & Sending CW via API 
 
Another new feature I'm really excited about is the ability to set 
up rig interface and / or send CW via API, which eliminates com 
port sharing problems among multiple programs.  Often, when I 
have Amateur Contact Log open to hunt DX, there might also be 
one or more contests that I want to dabble in as well (state QSO 
parties for example), but since Windows won't let programs 
share a com port, simultaneous rig interface and sending CW 
from multiple programs has been tough. 
 
Now, using the API in the latest versions, you can set up one 
program (usually Amateur Contact Log) as the server, connect 
AC Log directly to your rig interface and / or CW interface as 
always and then let any other N3FJP Software programs access 
your rig and CW interface as well, for simultaneous operation!  
Here's how: 
 
-  First, set up Amateur Contact Log for rig interface / CW 
interface normally (select your com port, etc.) and enable 
Amateur Contact Log's API Server (Settings > Application 
Program Interface and check the upper checkbox that says TCP 
API Enabled (Server)).   
 
-  For rig interface from the contesting program, click Settings > 
Rig Interface and select N3FJP API. 
 
-  For CW sending from the contesting program, click Settings > 
Transmit > CW setup and select the N3FJP API option. 
 

You'll now be able to keep both programs open, use rig interface 
and send CW from either one instantly! 
 
DX Spots Summary Graph 
 
Have you ever wondered if you are missing the hot band, or 
where to point your beam for the highest run rate?  From any 
program click View > DX Spots Summary Graph for a display 
of the most recent 200 spots by band and continent.  For 
example, if I'm just sitting down to do some contesting and I see 
a graph like the one below, where 20M and Europe have the 
most activity, I'll choose 20M and point my beam northeast to 
start. 
 
Since only spots that pass your filter (More Filtering button on 
the DX Spotting set up form) are tabulated, if you are only 
allowing spots posted from your country or call area, this will 
give you a great view of what's hot in your neck of the woods 
right now.   
 
This graph updates with each new DX spot, so you can keep it 
open if you like, to see your best bands and antenna orientations 
as the contest progresses! 
 
 
 
 
ID LoTW Users When Tabbing From Call Field 
 
As many of you know, Amateur Contact Log can be set to 
identify DX Spotted LoTW users with an L in the DX Spots list.  
That's great for spotted stations we work, but what about stations 
we come across that are calling CQ, or when we are calling CQ 
ourselves?  Now, when you click eLogs > LoTW > ID LoTW 
Users and check the check box to enable the feature, LoTW 
users will also be identified when tabbing from the Call field in 
the dialogue label. 
 
 
Additional API Commands (API Version 0.7) 
 
I have added additional API commands for developers of other 
software packages, who would like to interface with my 
software, including: 
 
-  Receive change events for the dialogue label. 
 
-  Ability to write text to and change color of the dialogue label. 
 
-  Set N3FJP Software to temporarily ignore rig polls (disables 
rig interface so your app can perform other functions that would 
be affected by rig interface). 
 
-  Determine the API version of the N3FJP Software program 
that you are connected to. 
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-  Retrieve operator info (call sign, latitude / longitude, etc.). 
 
-  Send Text to Speech. 
 
-  Receive F key presses or all keydown events. 
 
-  Do a lookup of the country list file based on a call sign. 
 
-  Locate, read and change the form size of N3FJP Software. 
 
-  Add records direct to the log file, with optional dupe checking 
on entry (alternative to Action Enter). 
 
-  Send CW. 
 
Complete details and all the specifications are here: 
 
http://www.n3fjp.com/help/api.html 
 
Everyone, if you have a program that you would like to see 
interfaced with my software, please take a moment now, contact 
the developer and refer them here: 
 
 
http://www.n3fjp.com/help/api.html 
 
It may be your prompting that will help make the difference! 
 
Winter Field Day Contest Log 1.6 Now Available! 
 
Following the great success of this past January's Winter Field 
Day, the WFD folks have made some small rule tweaks designed 
to make Winter Field Day 2017 even better!  Versions 1.5 and 
earlier will not accept all of the new category exchange options, 
so you must upgrade to version 1.6 for WFD 2017. 
 
Just a quick note to avoid some confusion - the Winter Field Day 
web site currently shows updated rules for 2017, but there have 
been some additional rule changes that the WFD folks haven't 
published yet.  Version 1.6 is designed around the rule set the 
WFD folks just e-mailed me direct last week, which should 
appear on their web site shortly. 
 
As always, upgrades are free to registered users.  You'll find 
Winter Field Day Contest Log version 1.6 here: 
 
http://www.n3fjp.com/winterfieldday.html 
 
And the upgrade steps here: 
 
http://www.n3fjp.com/upgradestepscontest.html 
 
Enjoy! 
-- 
 
As you've just read, a lot has gone into this round of upgrades.  I 

really hope you enjoy the new free features and enhancements!  
You can download the latest programs from their respective 
download pages on www.n3fjp.com.  Please be sure to follow 
the upgrade steps below the download link.  
 
 

BUY, SELL, or SWAP 
 
GE EXEC TWO REPEATERS= 
ONE IS A VHF WITH ENCODE-DECODE BOARD,HAS A 
T1000V CONTROL BOARD. 50 WATT UNIT. 
 
GE EXEC TWO REPEATER ON UHF WITH ENCODE AND 
DECODE BAARD. HAS A T1000V CONTROL BOARD. 50 
WATTS. 
CONTACT WIL  WB5YFX FOR MORE INFO. 
 
 
 

Hamfests & Events 
 
 
07/16/2016 | Tidelands ARS Hamfest  
Location: Texas City, TX 
Sponsor: Tidelands Amateur Radio Society 
Website: http://tidelands.org 
 
08/05/2016 | Texas State Convention (Austin Summerfest 2016) 
Location: Austin, TX 
Sponsor: Austin ARC & Texas VHF-FM Society 
Website: http://www.austinsummerfest.org 
 
09/10/2016 | Lubbock ARC's 3rd Annual Hamfest  
Location: Lubbock, TX 
Sponsor: Lubbock Amateur Radio Club 
Website: http://K5LIB.org 
 
 

NFLARC Weekly Information Net  
 
Net meets every Wednesday night at 9:00 PM local time 

·  The Linked Repeaters at 
o Corsicana - 2M (145.290 + with a tone of 

146.2) 
o Buffalo - 2M (147.280 + with a tone of 146.2) 
o Franklin - 2M (146.960 - with a tone of 146.2) 
o Hillsboro - 2M (146.780 - with a tone of 

123.0) 
o Fairfield * 2M (145.110 * with a tone of 

146.2) 
o Lindale * 2M (145.600 simplex with a tone of 

146.2) 
o Mexia * 2M (145.39 - with a tone of 146.2) 
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o Echolink * KD5OXM-L 
·  We can be Monitored via 

o http://nflarc.org/radio.html 
o http://www.radioreference.com 

�  “Central Texas Amateur Repeaters” 
�  “Navarro, Freestone, Limestone and 

Leon Counties Repeaters” 
 
 

Net Control Schedule 
 
·  June 

·  01 Jason / Wil 
·  08 Bud / Bud 
·  15 Michael / Doug 
·  22 Jason / Wil 
·  29 Bud / Bud 

·  July 
·  06 Michael / Doug 
·  13 Jason / Wil 
·  20 Wil  / Bud? 
·  27 Michael / Doug 

 
 
If you would like to learn or practice being net control, contact 
us here http://nflarc.org/email.html 
�

NFLARC Scheduled Club Meetings   
 
 
July 9, 2016 
NFLARC Lunch Time: 12:00pm - 1:00pm 
NFLARC Meeting Time: 1:00pm - 3:00pm 
 
August 13, 2016 
NFLARC Lunch Time: 12:00pm - 1:00pm 
NFLARC Meeting Time: 1:00pm - 3:00pm 
 
September 10, 2016 
NFLARC Lunch Time: 12:00pm - 1:00pm 
NFLARC Meeting Time: 1:00pm - 3:00pm 
 
October 8, 2016 
NFLARC Lunch Time: 12:00pm - 1:00pm 
NFLARC Meeting Time: 1:00pm - 3:00pm 
 
November 12, 2016 
NFLARC Lunch Time: 12:00pm - 1:00pm 
NFLARC Meeting Time: 1:00pm - 3:00pm 
 
December 10, 2016 
NFLARC Lunch Time: 12:00pm - 1:00pm 
NFLARC Meeting Time: 1:00pm - 3:00pm 

 
 

Other Area Nets 
 

·  HF 
·  10 mtrs Tues 8:00p 28.437 + or – W5DXS net 
·  40 mtrs M-Sat 10:00-noon 1:00-2:00p Sat 10:00a-noon 7.290 
·  80 mtrs 24/7 6:30p SW Traffic Net 3.873 
·  80 mtrs 24/7 8:00p-9:00 Gulf Coast Hurricane Net 3.935 

 
·  U/VHF 

·  Daily- 
·  4:00 a -an informal net on 146.580 Simplex every 

morning, Come and visit with the bunch! 
·  Mon-           

·  7:00p 146.82 and Waco area 146.660 linked Temple ARC  
·  8:00p 145.150 Hotarc Bakers Dozen Training net (WX Net) 

·  Tue-            
·  7:00p -147.180  Bosque County ARC Round Table Net 
·  7:00pm  BrandMeister DMR Statewide Net 3148 talkgroup - 

This is a Digital mode Net to participate you must use a DMR 
Radio on a Repeater that has BrandMeister Texas Statewide 
Channel Set up TG9000. All licensed radio operators are 
welcome to check in. 

·  7:30p  147.180  Pink HAMster net 
·  7:30 P. M The 2-meter SSB group is using 144.200 USB on 

Tuesday nights.   
·  8:30p- 147.24 (97.4 tone) Slo-scan Emergency Preparedness 

Net 
·  9:00p- 147.140, 97.4 SlowScan-ATV Talkabout Net 
·  10:00p  147.360 PL Tone 110.9  Tarlton Area ARC 

·  Weds.          
·  7:30 p.m. DMR Texas Net - This is a Digital mode Net to 

participate you must use a DMR Radio on a Repeater that has 
Texas Statewide Channel Set up. All licensed radio operators 
are welcome to check in. 

·  7:30 p.m. W5TSG Emergency Relay Net SIMPLEX . 147.550 
All checkins during the 7:30 net will have an opportunity to 
make comments on the 8:00 p.m. net 

·  8:00 p.m. W5TSG Traffic and Training Net 147.320 with a tone 
of + 123 

·  8:00pm ON THE LAST WEDS. OF THE MONTH ON 145.31 
TONE 123 THE W5TSG TRAFFIC AND TRAINING NET. 
All licensed radio operators are welcome to check in. Bud 
AD5SK Net Control 

·  9:00p- 146.78 Quad County net (NFLARC Linked repeaters) 
·  9:00 PM  Metroplex AMSAT- Arlington ARC Repeater 

147.14+, 110.9 Hz Tone 
·  Thurs.          

·  7:00p   146.78 LWARS Training Net 
·  7:30p Texas DMR Swap net 1st Thursday of the month. This is a 

Digital mode Net to participate you must use a DMR Radio on a 
Repeater that has Texas Statewide Channel Set up. All licensed 
radio operators are welcome to check in. 

·  8:00p   147.14 Central Texas ARC Net (WX Net) 
·  8:00p  145.310, 123.0 Central Texas Amateur Radio Net 
·  DMR Tech Net 

·  0100 UTC in Summer 
·  0200 UTC in Winter months 
·  North America English Talkgroup (3) 

·  Sat. 
·    Worldwide DMR-MARC Net  

·   1600 UTC 11pm cst in Summer,  
·  1700 UTC 12pm cst in Winter months  
·  Worldwide Talkgroup (1)    
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·  Sun. 
·  7:30p     444.00 tone 136.5 and 145.45 tone 88.5 Johnson 

County ARC (Cleburne) 
 

AREA CLUB MEETINGS  

·  All-Ham Breakfast                 
o Every Sat.9:00am GRIFFS at China Spring Road & 

Wortham  Bend Road in China Spring. Come join your 
fellow hams every Saturday morning. 

·  Bosque County ARC             
o  2nd Sat. 6:30pm Johnny’s Café on HWY. 6 In Clifton 
o VEC team there to give a test or upgrade at 5:30 each 

meeting 
·  Central Texas ARC                

o 1st Tues. 7:00pm Belton EOC 
·  HOTARC                                

o 4th Thurs. 7:00pm W5NCD Workshop 12772 Chapel Rd., 
Lorena 

·  Lake Whitney ARS                 
o 3rd Sat. 10:00am Whitney Fire Department 

·  Leon County Ham Radio Club 
o 1st Tues. 7:00 p.m. at the Centerville Municipal Building, 

also known as the fire station. The building is located just 
past Lacy's Grocery Store on the right 

·  Temple ARC                           
o 1st Thurs. 7:00pm Western Hills Church of Christ Adams 

& I-35, Temple 
·  W5TSG  ARC                         

o 2nd Monday  6:30pm  TSGARC Clubhouse 3292 
Speegleville Road, Waco 

·  Tarleton Area ARC                 
o 1st Tuesday of each month Stephenville (also a 70cm 

repeater available 444.775 PL tone 88.5) 
·  CCARC - Cedar Creek Amateur Radio Club 

o Second Saturday of each month at the Mabank Cafe, 301 
N. 3rd. Street in Mabank.   

o Their meeting room is a no-smoking area for us all 
morning. 

 
 

CONTEST CALENDAR 
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Amateur Satellite 
 

 

 
 
Elementary School's SSTV CubeSat ISS Deployment 
 
After postponements earlier this year, the STMSat-1 CubeSat 
constructed by pupils at St Thomas More (STM) Cathedral 
School in Arlington, Virginia, was deployed Monday 16 May 
2016. 
The spacecraft is equipped with a slow-scan TV (SSTV) payload 
that will transmit on the 70 centimeter Amateur Radio band 
(437.800 MHz). 
The school won a NASA competition for the launch. The 
satellite is the first to be designed and built by grade schoolers, 
who have been supported by NASA technical advisors and local 
radio amateurs. 
Transported to the ISS in December by an Orbital ATK Cygnus 
spacecraft, the kit-built satellite first had been scheduled for 
release in mid-February, but that event was postponed until early 
March, before being put on hold again. 
"The STM Sat-1 mission is to perform Earth observation and 
engage grade-school students around the world as remote 
Mission Operation Centers," the STMSat-1 website explains. 
The satellite project is part of the school's STEM (Science, 
Technology, Engineering, Mathematics) education initiatives. St 
Thomas More includes students from pre-kindergarten through 

grade 8. The project aims to engage other schools around the 
world as "Remote Mission Operation Centers". 
NASA's Technology Demonstration Office provided the school 
with a mobile "clean room" to ensure that the construction phase 
met with strict guidelines and standards for launch and 
deployment from the ISS. The space agency also provided the 
school with an antenna, so the school can receive the SSTV 
images and temperature readings the satellite sends back. The 
students already have tested their CubeSat by sending it aloft on 
a tethered balloon. 
The SSTV camera onboard STMSat-1 will transmit a Martin-2 
image every 30 seconds. It will not transmit a beacon signal, 
however. The youngsters are hoping it will send back images of 
Earth as seen from space. The transmitter runs 3 W, and there is 
no onboard data storage capability. 
STMSat-1 has an estimated lifetime of at least 9 months. 
 
STMSAT-1 - http://www.stmsat-1.org/rmoc/ 
 
 

Digital Radio News 
 

 
 
DMR Static Talk groups  
 
For BrandMeister hotspot users....... . 
 
I see that servers 3103, and 3108 are using the new software that 
makes the talk groups static. I am logged on to 3108, and it has 
been 50 minutes since I keyed up to log on to TG3148. I just 
heard W5RIR on 3148, so I am going to say the new software 
works. Hopefully, Robert will update server 3102 with the new 
software tonight. 
 
Keep the faith folks....... after servers 3101, and 3102 are 
upgraded, we won't have to key up every 15 minutes to monitor 
a talkgroup. 
 
--  
Bob Woodson - WB5NIA 
 
---------------------------------------------------------------------------- 
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Corsicana DMR 
 

 
Corsicana DMR Repeater after install 
 
-------------------------------------------------------------------------- 
 
Is DMR a mass adoption phase winner in digital voice radio? 
 
From http://www.kb6nu.com/dmr-winning-digital-race/ 
 
Recently, someone forwarded an e-mail from Rick, K1RJZ, to an 
amateur radio mailing list that I subscribe to. I found Rick’s 
comments to be so right on, I asked him if I could publish them 
here as a guest post, and he agreed. Thanks, Rick! 
 
At Dayton this year, it was no surprise that digital technologies 
got a lot of attention, including HF software-defined radios 
(SDRs), like the ICOM IC-7300 and the FlexRadio 6000 series, 
and VHF/UHF digital radios, such as the Tytera DMR radio that 
sells for about $130. Hams are excited about digital radio 
because it is something new to explore. As you can see below, it 
was standing room only at the DMR Forum at Dayton this year. 
 

 
 
One of the reasons for this excitement is that they are software-
based, and unlike hardware radios, SDRs (some are really HF 
radio servers) are easily upgraded, and manufacturers can add 

compelling new features as technology changes. That means that 
you get a new radio every year without needing XYL approvals! 
If you follow technology (smartphones, laptops, the internet, 
whatever), you know that there are certain common phases that 
all technologies must pass through. These include the pioneer 
stage, the early adopter stage, and then “the chasm.” Once a 
technology adoption has survived these three stages, it then 
reaches the mass adoption phase, and it begins to grow very 
quickly. Competing technologies then need to adopt. If they 
don’t, they will eventually fall by the wayside. 
 
There is no question that DMR 
technology (Digital voice Mobile Radio) 
for hams has jumped the chasm and is 
now into the mass adoption phase, and 
may soon enter the low-priced 
commoditization phase. Inexpensive, 
mass-produced Chinese DMR digital 
voice + FM portable radios were being 
sold inside the Hara arena for as low as 
$109 with a color display and free 
programming software. Remember that 
these are Part-90 type accepted, 
commercial-quality radios, not low end 
junk with dirty transmitters and low 
quality RX audio. 
In addition, there were many used, first 
generation Motorola DMR radios for 
sale in the flea area. These radios 
perform just as well as the current 
models, but have less memory. From 
what I saw at Dayton, I have no doubt 
that DMR is on a run and is now well 
into the low-priced mass adoption phase. 
D-STAR, Fusion and to a lesser extent 
NXDN are all established and are not 
going away, but in many areas they are 
not experiencing any meaningful growth 
when compared to DMR.  
 

 
 
The Tytera MD-380 
DMR radio was 
going for $109 at 
Dayton. The normal 
price is around 
$130. 

D-STAR repeaters in New England, for example, have been 
converting to DMR because DMR radios are far cheaper than D-
STAR radios, have more features, and have far superior 
networking. ICOM D-STAR repeaters have not been highly 
successful in high-RF areas, such as you typically find on top of 
skyscrapers and busy mountaintop sites. The D-Star technology 
is way cool, the ICOM repeater hardware… much less so.  Some 
repeater clubs have figured out ways to use non-ICOM RF guts 
for their repeaters, and those have been successful, but it also 
takes some smart techie-hams to pull that off.   A tip of my hat 
to them! 
Many clubs are wisely taking advantage of the subsidized Yaesu 
Fusion repeater offers but most in New England seem to be 
using them in either dual mode or FM-only Mode. Fusion in 
digital mode has been very slow to get traction in these parts of 
the world. It is not a bad format, but Yaesu got in the game very 
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late, Fusion is proprietary and has far fewer working features 
than other technologies.  As a big plus, Fusion in high-
bandwidth mode can send pictures such as “ground truth” 
weather status pictures.  Most other digital voice modes cannot 
do hat. 
NXDN, another commercial digital voice format used by the 
railroad industry, has some pockets of ham activity such as in 
southeastern Massachusetts but nationwide adoption is very 
slow. I don’t want to sound biased, I’m just reporting what I am 
hearing from multiple face-face sources and Dayton 
presentations. 
None of these digital voice technologies or FM will go away and 
all of the digital modes are generating a lot of interest in the 
hobby. They are all fun and if you are a ham, you will have a 
ball trying them out. I have used D-STAR and P25 digital voice 
for years, and though I have yet to try Yaesu Fusion, I am very 
much looking forward to it. But, from what I saw at Dayton, 
DMR now seems to be a serious leader the digital voice 
technology adoption curve. 
 
-------------------------------------------------------------------------- 
 
DMR Brandmaster Talk Groups 
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QSL Card 
 

 
 
 

Web LINKS 
 

 
(''.9::&&&��-,�'�)��: �
�
�

 
http://qrznow.com/ 
 

 
http://new.dxsummit.fi/#/ 
 
 

 
http://www.qrz.com/ 
 

 
http://www.repeaterbook.com 
 

 
http://www.southgatearc.org/index.htm 
 

 
http://www.hornucopia.com/contestcal/index.html 
 

 
http://icqpodcast.com/ 
 

 
WIA - http://www.wia.org.au/ 
 

 
South African Radio League (SARL) - http://www.sarl.org.za/ 
 

 
http://www.grapevineamateurradio.com/ 
http://www.livefromthehamshack.tv/ 
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http://www.n3fjp.com 
 
 
The Spectrum Monitor 

 
Online magazine 
http://www.thespectrummonitor.com/index.aspx 
 
 

 
http://www.lidomounts.com 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

SILENT KEYS 
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KE5RY 
Kerry W Friddell 
8650 Wednesbury Lane Apt. 101 
Houston, TX 77074 
 
Became Silent Key 5-28-2016 
While I did not meet or have a QSO with him, If you listened to 
the Saltgrass at all, You heard him. 
Kerry was always on the radio chatting or helping another 
operator. As everyone on Saltgrass is saying, “This Great Ham 
Radio Operator will be missed”. 
 
KE5RY SK 
 
 

FYI 
 

·  NFLARC Club Dues are due every May 
 

Ham Radio Glossary 

S 
 
Safety interlock -- A switch that automatically turns off ac 
power to a piece of equipment when the top cover is 
removed. 
 
Schematic symbol -- A drawing used to represent a circuit 
component on a wiring diagram. 
 
Selectivity--The ability of a receiver to separate two closely 
spaced signals. 
 
Sensitivity--The ability of a receiver to detect weak signals. 
 
Series circuit -- An electrical circuit in which all the 
electrons must flow through every part of the circuit. There 
is only one path for the electrons to follow. 
 
Shack -- The room where an Amateur Radio operator keeps 
his or her station equipment. 
 
Short circuit  -- An electrical circuit in which the current 
does not take the desired path, but finds a shortcut instead. 
Often the current goes directly from the negative power-
supply terminal to the positive one, bypassing the rest of the 
circuit. 
 
Sidebands -- The sum or difference frequencies generated 
when an RF carrier is mixed with an audio signal. Single-

sideband phone (SSB) signals have an upper sideband (USB 
-- that part of the signal above the carrier) and a lower 
sideband (LSB -- the part of the signal below the carrier). 
SSB transceivers allow operation on either USB or LSB. 
 
Silent Key -- SK. Euphemism for a deceased Amateur 
Radio operator. In the Western Union company's "92 code" 
used even before the American Civil War, the number 30 
meant "the end. No more." It also meant "good night." In 
Landline Morse, 30 is sent didididahdit daaah, the zero 
being a long dash. Run the 30 together and it has the same 
sound as SK. 
 
Simplex operation -- Receiving and transmitting on the 
same frequency. See duplex operation. 
 
Single Sideband (SSB) phone -- A common mode of voice 
operation on the amateur bands. SSB is a form of amplitude 
modulation.The amplitude of the transmitted signal varies 
with the voice signal variations. 
 
Single-pole, double-throw (SPDT) switch -- A switch that 
connects one center contact to one of two other contacts. 
 
Single-pole, single-throw (SPST) switch -- A switch that 
only connects one center contact to another contact. 
 
Skip zone -- An area of poor radio communication, too 
distant for ground waves and too close for sky waves. 
 
Sky-wave propagation -- The method by which radio 
waves travel through the ionosphere and back to Earth. 
Sometimes called skip, sky-wave propagation has a far 
greater range than line-of-sight and ground-wave 
propagation. 
 
SOS -- A Morse code call for emergency assistance. 
 
The American delegation suggested the letters NC which 
were already recognized in the International Signal Code for 
Visual Signalling. The German delegation proposed its own 
SOE, which was already in use on German ships as a 
general inquiry signal similar to CQ (which was then used 
only by the Marconi system). The British delegation 
wanted  the Marconi signal CQD. 
 
The convention found SOE acceptable except that the final 
E could easily be lost in QRN so the letter S was 
substituted, making it SOS. The convention decided that 
SOS should be sent as a single code character with a sound 
unlike any other character, thus arresting the attention of 
anyone hearing it. In 1912, after the Titanic disaster, SOS 
became universal. 
 
Space station -- An amateur station located more than 50 
km above the Earth's surface. 
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Specific absorption rate (SAR) -- A term that describes the 
rate at which RF energy is absorbed into the human body. 
Maximum permissible exposure (MPE) limits are based on 
whole-body SAR values. 
 
Splatter -- A type of interference to stations on nearby 
frequencies. Splatter occurs when a transmitter is 
overmodulated. 
 
Spurious emissions -- Signals from a transmitter on 
frequencies other than the operating frequency. 
 
Standing-wave ratio (SWR) -- Sometimes called voltage 
standing-wave ratio (VSWR). A measure of the impedance 
match between the feed line and the antenna. Also, with a 
Transmatch in use, a measure of the match between the feed 
line from the transmitter and the antenna system. The 
system includes the Transmatch and the line to the antenna. 
VSWR is the ratio of maximum voltage to minimum 
voltage along the feed line. Also the ratio of antenna 
impedance to feed-line impedance when the antenna is a 
purely resistive load. 
 
Station grounding -- Connecting all station equipment to a 
good earth ground improves both safety and station 
performance. 
 
Sunspot cycle -- The number of sunspots increases and 
decreases in a predictable cycle that lasts about 11 years. 
 
Sunspots -- Dark spots on the surface of the sun. When 
there are few sunspots, long-distance radio propagation is 
poor on the higher-frequency bands. When there are many 
sunspots, long-distance HF propagation improves. 
 
Switch -- A device used to connect or disconnect electrical 
contacts. 
 
SWR meter -- A measuring instrument that can indicate 
when an antenna system is working well. A device used to 
measure SWR. 
 
 

2015-2016 Officers     
 
President: Doug S - KE5CDK 
Vice President: Rodger W - W5UOK 
Secratary: Rebekah M - K5RCM 
Treasurer: James S - KD5OXM 
Director (1yr):  Mary S - KE5FGU 
Director (2yr):  Kevin M - KW5MOS 
Director (3yr):  Michael B - KF5KHS 
Field Day Committee:  
Testing Committee:  Rebekah M - K5RCM 

VE Team Rebekah M - K5RCM 
Public Relations Chairman  Rebekah M - K5RCM 
Activities Chairman Rebekah M - K5RCM 
Ragchew Editor Doug S - KE5CDK 

 

Address Book 
 

·  Staff@nflarc.org - Is sent to pres, vp, sec, tres, & board 
·  members@nflarc.org - Is sent to all members on the 

mailing list 
·  vec@nflarc.org – Is sent to our VEC’s 
·  ve@nflarc.org - Is sent to the VE team 
·  ares@nflarc.org – Is sent to pres, vp, sec, tres, 
·  fd@nflarc.org - Is sent to pres, vp, sec, tres, 
·  ragchew@nflarc.org - is sent to the newsletter editor 

 
 
If you have Questions, Comments, Links, Submissions, 
Corrections,  Etc. 
Send them to ragchew@nflarc.org 
 
 
To subscribe to the newsletter, send a message to: 
  <newsletter-subscribe@nflarc.org> 
 
To remove your address from the newsletter, just send a message 
to: 
  <newsletter-unsubscribe@nflarc.org> 
�

73 DE W5NFL 


